Introduction

"Four of the six leading causes of death

-- diabetes, heart disease, cancer and obesity -- are related to nutrition
... [but] many doctors don’t ask questions about diet

until the patient has a heart attack."”

Dr. Steve Zeisel,

Chairman, Nutrition Department, University of North Carolina

(Associated Press)

With today's fast pace, together with the increasing demands from work, home and family, it is harder
than ever for a woman to maintain a healthy life-style. For centuries, women's health problems were
poorly understood and largely ignored despite the prevalence of serious medical problems such as
obesity, cancer, diabetes, etc. among women and their unique health status during pregnancy, lactation,
etc.

Women need nutritional information that reflects the marked differences between the needs of men and
women. NutriSoft Nutrition for Women helps users monitor their special dietary needs and
consumption:

More than 20 million people are affected by osteoporosis, most of them women over the age of forty-
five. Women are especially susceptible to osteoporosis because their bones are in general smaller than
men's. There are no symptoms of osteoporosis until a fracture occurs and, in women, smaller loss of
calcium can engender this condition. Both pregnant women and nursing mothers need to increase their
calcium intake during these critical periods. Adequate calcium intake is also crucial at the onset of
menopause when the abrupt loss of female hormones leads to decreased calcium absorption and
accelerated bone loss.

Iron deficiency is the most common cause of anemia, and iron deficiency anemia is the most common
form of malnutrition in women. Anemia occurs when the concentration of hemoglobin in red blood cells fall
below normal. Hemoglobin is essential for delivering oxygen from the lungs to the body's tissues. Severe
deficits in the delivery and use of oxygen increase fatigability, decrease work capacity, impair brain
function, and lessen ability to maintain body temperature.

Obesity among American women has reached epidemic proportions. The more severe the obesity, the
greater the incidence of stroke, osteoarthritis, menstrual irregularities, reduced fertility, fungal and yeast
infections, etc. Studies have indicated that even a modest weight loss can improve the health of millions
of people. The secret of losing weight and maintaining your weight loss is changing your lifestyle and poor
eating habits. With Nutrition for Women, it is easy to adopt good eating habits because you will be able to
choose from nutritious and natural food with real flavor. You will be able to design your own delicious,
well-balanced meals that maximize good nutrition and great taste while minimizing fat and calories.



About Nutrition for Women

"optimal nutrition for women throughout life is the best way to promote infant health"
U. S. Surgeon General

NutriSoft Nutrition for Women is based on the US Surgeon General's Report on Nutrition and Health and
the National Research Council dietary guidelines for women. The program is a convenient tool for users
to monitor their diet to achieve optimal health through proper nutrition. The software can be used by itself,
or in conjunction with diet programs from your favorite authors. Whether you are vegetarian, or follow any
special diet, or enroll in a weight-loss club, whether you are expecting a child or take care of older
women, etc., you will find that NutriSoft Nutrition for Women gives you better insight into your diet and
helps you make informed dietary decisions.

Database size and manual for this program:

The registered version of this program contains approximately 10,000 most commonly used food items
and users can add a theoretically unlimited number of their own foods.

There is no printed manual for this program. Please print any desired topics from this help file via the
'Print topic' command from the 'File' pull-down menu.



Dietary Guidelines
For weight control:
To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both.

Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake. The Food and Nutrition Board's Committee on
Diet and Health recommended that the fat content of the U.S. diet not exceed 30% of caloric intake.
NutriSoft Nutrition for Women calculates and displays graphic analysis of fat content for every food
entry (approximately 10,000 items in our professional database and also those from user's database)
as well as for your daily food consumption. The program also lets you set a fat warning level to easily
identify high-fat foods: when the specified percentage of energy from fat is exceeded, a red icon is
displayed and associated with a food item.

Sugar and alcohol provide calories from carbohydrate but no other nutrients, individuals seeking to
attain and maintain desirable body weight should use these substances sparingly. NutriSoft Nutrition
for Women separates these items into their own food groups for easy identification and avoidance.

In addition, extremely low calorie diets (300 to 400 kcal per day) should be avoided because it may be
difficult to meet essential vitamin and mineral requirements on low-calorie diets. Crash diets seldom
work if your objective is to lose weight permanently. First, when the weight you lose is mostly body
water, it will come back when you return to your normal routines. Second, severely restrictive diets
are not sustainable for most people on a long-term basis. NutriSoft Nutrition for Women helps you
identify inadequate diets. It also helps you design those that are healthy, varied and balanced
because the program lets you choose wisely from thousands of foods.

Evidence indicates that exercise burns calories, increases the proportion of lean to fat body mass,
and, therefore, raises the metabolic rate. Increased levels of physical activity are important for
attaining desirable body weights among the general population. The rule regarding exercising is to go
slow and steady. NutriSoft Nutrition for Women provides a convenient utility to help you determine
how much energy you expend through common activities and exercises. As a result, you can identify
those activities that may be ineffective or those that are too strenuous. In consultation with your
physician, you can devise an exercise program that is suitable to your physical condition.

When you design a diet for yourself, make sure that it is varied and balanced. [You can use the Food
Pyramid Analysis tool (available in our Pyramid Weight Loss Diet program) to determine if your diet
conforms with the USDA's Food Guide Pyramid.] In general, you should choose the foods that you
like so long as they are low in fat. Diet doesn't mean deprivation. The one simple adjustment you
most likely need to make is: reduce fat intake.

It is better to have several small meals than few big ones. People who have large, infrequent meals
tend to gain more weight than those who eat smaller quantities (but the same total) at regular
intervals. NutriSoft Nutrition for Women graphic analysis allows you to inspect and distribute your
nutrient intake evenly throughout the day as desired.

For pregnancy:

"Dietary risk factors include an inadequate intake of calories or essential nutrients such as
protein, vitamins, and minerals. Evidence indicates that the more of these risk factors
present, the greater the risk to mother and child."

U.S. Surgeon General

Weight gain
"Research has demonstrated that both maternal pre-pregnancy weight and weight gained



during pregnancy are important determinants of infant birth weight. Inadequate weight gain
during pregnancy and low pre-pregnancy weight combined with low weight gain are
associated with lower-than-average infant birth weights and greater risks for fetal or neo-
natal death and neo-natal disease; these problems decline as weight gain increases."

U.S. Surgeon General

Protein
Protein is abundant in American diet and studies have associated diets containing 20
percent of total calories from protein (as compared with the 12 to 14 percent usually
recommended) with a higher risk of premature deliveries and neonatal mortality. Therefore
protein intakes significantly higher than those recommended may be harmful.
Rush, Stein, and Susser 1980a Pediatrics 65:683-97, 1980b Pediatrics 66:656-57

Energy intake
The recommended intake of energy during pregnancy includes an increment of 300 kcal/day
over the energy allowances for nonpregnant women. This amount was obtained by
calculating the total energy cost of synthesizing maternal and fetal tissues and dividing this
figure by the number of days of pregnancy.
National Research Council 1980

Fat and carbohydrate intake
The Food and Nutrition Board's Committee on Diet and Health recommends that more than
half the energy requirement beyond infancy be provided by carbohydrates and that the fat
content of the U.S. diet not exceed 30% of caloric intake.

National Academy of Sciences 1989

Iron

The need for iron is increased during pregnancy, with about 500 mg needed to increase the
number of maternal blood cells, about 600 mg needed for the fetus and placenta, about 200
mg needed to replace normal maternal losses, and another 200 mg needed to replace the
red blood cells lost during delivery. The National Research Council recommends an iron
supplement of 30 to 60 mg per day to prevent depletion of iron stores during pregnancy and
lactation.

National Research Council 1980

Calcium
The newborn contains approximately 30 g of calcium, most of which is deposited during the
third trimester of intrauterine development. A calcium intake of 1,200 mg throughout
preghancy and lactation is recommended regardless of age. However supplementation to a
total calcium intake much above the RDA is not recommended because ingestion of very
large amounts may result in hypercalciuria, hypercalcemia and deterioration in renal
function in both sexes.

National Academy of Sciences 1989

For general maintenance of proper nutrition:

Calcium
Both pregnant women and nursing mothers need to increase their calcium intake during
these critical periods. Adequate calcium intake is also crucial at the onset of menopause
when the abrupt loss of female hormones leads to decreased calcium absorption and
accelerated bone loss.

Protein
Adequate dietary protein is essential for bone growth; the skeleton is second only to muscle in terms of
total body protein content. Abnormal protein nutrition may cause osteoporosis, and a decreased protein



intake could contribute to the decline in bone mass observed in alcoholics. However, high protein intake
may also cause bone loss. In young individuals, increasing dietary protein intake increases calcium
excretion in urine and produces a negative calcium balance. To reduce the possibility of losing bone mass
and becoming susceptible to bone fractures, the daily protein intake should be within the National
Research Council's RDA.

Iron
Iron deficiency is the most widespread nutritional deficiency facing women. Women are affected by iron
shortages because they lose iron in their menstrual blood each month. Iron shortage can result in
tiredness and susceptibility to infection.

Important: The dietary guidelines contained in this program are derived from research published by US
government agencies and by private non-profit health organizations. The nutritional guidelines in this section are for
your information only. Before adopting any diet, please obtain approval from your physician.



Disclaimer

The data and nutritional guidelines contained in this program are derived from research published by US
government agencies and by private non-profit health organizations. The data and guidelines are
compiled for your information only and must not be construed as medical advice or instruction. The
decision concerning diet or medications should be made by you and your doctor. Before adopting any diet
or exercise program, please discuss your condition with your doctor and obtain his/her approval. NutriSoft
disclaims all liability in connection with the use of this program.



New Features

Below is a list of new features which are common to all NutriSoft products. Specific new features which
are applicable to a particular program are not listed.

New features with version 3.5 or later:

1. weight tracker utility allows you to maintain a graphic history of your weight loss progress.

2. diet tracker utility lets you keep track of your diet over time.

3. target heart rate calculator helps you get the most benefit from your exercise.

New features with version 3.2 or later:

1. percentages of calories from fat, protein and carbohydrate are now graphically displayed in addition to
the nutrients' weights. Each full section of the bar represents 10%. When the percentage of calories
from fat exceeds the user specified value, the bar is displayed in white instead of dark gray.

2. toggling left mouse button quick input mode: you can now turn this feature on/off as desired.

3. right mouse button quick input mode has common serving sizes as option in addition to gram and
ounce.

New features with version 3.0 or later:

1. most programs come with a professional food database containing approximately 10,000 food items
(registered version); some programs still use a standard food database of approximately 1,000 most
commonly used foods. Please carefully evaluate this difference before ordering.

2. more sophisticated food search capability: 'not' and 'and’' Boolean search; global and local search

3. quick serving amount data entry

4. quick find: locate food consumed that is highest or lowest in a particular nutrient.

5. copy, cut and paste meals: editing food data is easier and easier because you can conveniently reuse
previously edited meals.

New features with version 2.x or later:

1. user's food database support,

2. printer font selection

3. screen color selection,

4. graphic analysis of nutrients,

5. RDA analysis,

6. context sensitive help,

7. set fat warning level



8. sorting based on nutrient contents, etc.

All previously available features are retained or improved.



About NutriSoft food databases

The registered food database of the following programs contains approximately 1,000 most
commonly used food items.

1. Fat and Cholesterol Counter 1.1

2. Control Diabetes 1.2

3. Pregnancy Nutrition 2.1

4. Pyramid Weight Loss Diet 3.4

5. Healthy Heart Nutrition 3.5

If you need a larger food database, please consider registering for any of the following programs
which have a 10,000-entry food database:

Reduce Cancer Risk 3.0

Weight Perfect 3.0

Lower Your Cholesterol 3.2

High Blood Pressure Nutrition 3.2

Diabetic Nutrition 3.3

Nutrition for Women 3.5
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The registered version of the food database for most NutriSoft programs version 3.0 or later contains
approximately 10,000 food items divided into 50 or so food groups. You can expect to find from the most
common items to the more exotic foods. The shareware version of the database gives you a sample of
the range of foods contained in the registered database.

Abbreviations:
To conserve space and to make the display of food names less cluttered, we have adopted a few
abbreviations.

NFS not further specified
ckd cooked
ckg cooking
incl include / including
excl exclude / excluding
w/ with
w/o without

Note:

Food items containing a general or nonspecific description, for example, "Beef, not further specified" have
been assigned nutrient values for a commonly eaten form of the food or for a composite of several forms.
Values for most items containing two or more ingredients were calculated from ingredient data using
representative recipes.

Nutrient values associated with specific brand named products were supplied by the companies in most
cases. When not supplied by companies, values were estimated. Estimates are based on product
ingredient lists, or on values for similar products.

Mention of commercial products in this database is solely for identification purposes and does not
constitute endorsement over other products not mentioned.

See also User Food Database.



Main Uses of the Program
NutriSoft Nutrition for Women can do many useful things for you:

At the simplest level, it can determine your ideal weight and recommend the most healthful levels of
nutrient and caloric intake to you. You can browse through the extensive food database and select the
foods that provide the nutrients you need and avoid those that have too much fat, for example. You can
view and print graphic analysis of your diet.

However, two of the more important uses of "NutriSoft Nutrition for Women" are to analyze your current
diet and to establish a weight control plan.

A typical scenario for the former case: you record the foods you eat at each meal during the day, then
print out the analysis to see if your current diet is too high in fat, deficient in carbohydrate, etc. You can
also determine if your caloric intake is spread out rather evenly throughout the day or heavily
concentrated at a particular meal. [Some weight control plans recommend that the caloric intake is spread
out evenly throughout the day.] Using the caloric analysis dialog box, you can also determine if too many
calories in your diet come from protein or fat and modify your diet accordingly. Make sure you print out a
hard copy of the analysis for a comprehensive view of your day diet. Each day's food consumption can be
saved for future use. You can save the files as Mon, Tue, Wed or 0925 (for September 25th) or day1,
day2, etc., the program will automatically add in the file extension. Use whatever file names that you can
easily remember. A convenient scheme is to name your files according to their caloric contents. For
example, 1200a, 1200b, 1800a, 1800b, etc. When you need a low-calorie diet, you can easily select the
appropriate files for consideration.

To establish a diet plan to lose or gain weight, you prepare the menu for each day by recording the foods
you are going to eat for each meal. For simplicity, let's assume you are going to repeat the menu cycle
every week. In this case, you will prepare 7 files (naming them Sun, Mon, Tue, Wed, Thu, Fri and Sat)
and record the foods you plan to eat for each meal in these files. Once these files are saved, you bring up
the Weight Control Plan dialog box. The files should show up in the right list box. You then add all 7 files
to your plan. After adjusting your weight and activity level, you will have an accurate picture of how much
weight you will gain or lose when you follow this plan of diet. You can go back and adjust the food data in
the files if you find that you are eating more or less than what is required to achieve your weight goal.



RDA Analysis

The RDA figures are for the average normal and healthy people in the United States under usual
environment stresses. Your optimal personal requirements may be different. In addition, diets should
be based on a variety of common foods to provide other nutrients for which human requirements have
been less well defined.

The RDA analysis is color coded as follows:

- yellow : below RDA i.e., too little

- green : within RDA i.e., just about right (91 -130 % )
- magenta :above RDA i.e., more than enough

-red : well-above RDA i.e., much more than needed

In general, you should strive to achieve a balanced diet which is reflected by the green bars the analysis
displays. Excessive consumption of certain nutrients is not desirable.

You can set your own preferred nutrient intake levels and the analysis colors are modified accordingly: a
yellow bar is displayed when the current intake is below your desired range; green when within range;
magenta when moderately above range and red when much higher than your preferred range.

Strictly speaking, there is no RDA for carbohydrates. However, the Food and Nutrition Board of the
National Academy of Sciences recommends that more than half the energy requirement beyond infancy
be provided by carbohydrates.



Modifying the Daily Food Consumption

To modify a daily food consumption document, you first select a meal you want to record the data for.
There are 6 meals in a day: Breakfast, Morning Snack, Lunch, Afternoon Snack, Dinner and Evening
Snack. Select one from the left pull-down list box.

Then you select a food group from the right hand side pull-down list box. ( Depending on the program's
database, there are approximately 30 to 50 food groups.) It is easy to get to the food group you want:
once the input focus is at the food group combo box (by tabbing to or clicking the mouse on this control),
you can type just the first letter of the food group and the next group name starting with that letter will be
displayed. Repeating a character will cycle all the group names with that starting character through the
combo box.

displays food group names in normal order.

displays food group names in reverse order.

[Alternatively, instead of the Food Group mode, you can specify the Search mode from the Options menu.
Or you can use your own food database.]

Select a food item in the right listbox, click on the 'l Eat' button. This item will be recorded in the meal you
selected.

Starting with version 2.3 of our software, you can sort the food list on any individual nutrients. Select
either the ascending or descending order via the blue or red triangular sort icons near the lower right
corner of the food list box, a floating menu will appear inside the listbox, you can then select the nutrient
you would like to sort on. Once the list box is sorted, you can single click on a food item to review its
nutrient's content. Please note that from version 3.0, the nutrient contents sorted on are normalized to be
based on each 100g of food item; this makes direct comparison between food items easier. A sort is valid
only for the current content of the list box, this means if you move to another food group or do another
food search, the new content will be listed in alphabetical order (except for the search content). When the
list box is sorted, a small square appears inside a sort icon to indicate which sort sequence is in effect.

If necessary, you can adjust the amount consumed for this food item by typing the desired amount in the
edit control above the 'Am(oun)t. OK' button. Once the right amount has been typed in, click on 'Amt. OK'
to confirm and record this value. (Hint: Click left or right mouse button on the window's background to
select a standard food amount for fast adjustment of quantity.)

If a food item is not what you intended to add to a meal, you can highlight it and then click on the 'Delete’
button to remove it from your meal.

You can display the graphic caloric analysis of a food item in a meal by selecting an entry in your meal
food consumption then click on the graph icon. A graph will appear to show you the percentages of
calories of this food item that come from fat, protein and carbohydrate. To review the caloric analysis of
your day food consumption, select the 'Caloric analysis..." menu item from the 'View' menu.

Repeat the food selection process for each meal, omitting the meals where you don't eat any food.

When you are done, you can save the day food consumption data for later review or for use in your
weight control planning.
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- You can use 'Copy Meal' and 'Paste Meal' buttons on the toolbar for fast entry of food data when the
same foods are eaten at different meals.

- Use 'Find Max' and 'Find Min' buttons to quicky identify foods eaten that are high in fat or low in
carbohydrate, etc.

See also the Analysis Panel



The Analysis Panel

The analysis panel is the gray panel in the lower half of your screen. The panel is divided into 6 sections:

1. the Information section contains the names of the nutrients being analyzed and the weight or serving
size of a food item.

2. the Food Item, Meal Total, and Day Total sections contain the numerical values of the contents of
various nutrients in the food item, in a meal, and daily diet, respectively. They also show the caloric
percentages from protein, carbohydrate and fat in bar graph format. Each full fraction of a bar
represent 10% of caloric contribution from the nutrient. When the percentage of calories from fat
exceeds that of user's specified value, the bar color is displayed in white instead of dark gray.

3. the %RDA section shows the percentage of Recommended Dietary Allowances for your daily diet
both numerically and graphically. The color of the bar graph correspond to user's own personal
Nutrient Intake Preference.

4. the Unit section lists the unit of measurement for each analyzed nutrient.



Edit meals

If you would like to reuse a meal (or repeat a few food items) in your diet, here is a convenient way to do
so: prepare the meal (or the food items) you plan to reuse. Copy or cut it to the clipboard; then go to
another meal or open another day's file and paste to a new meal! The serving information is retained, not
just the food name. When you insert a meal into a partially planned meal, the inserted food items will
appear immediately below the currently selected food item in the receiving meal.

You can also delete all food items from a meal by using the Edit Clear All command or the Clear All icon.



Food Groups Mode

In this mode, the default mode, you will see a pull down listbox that contains approximately 50 food
groups such as "Cookies", "Qils", "Beef", etc. By selecting any of these food groups, the food items
belong to the group will be displayed in the list box immediately below. This mode is useful when you
want to browse through the standard database, or when you want to do your menu planning which
requires selection of foods from different food groups.

Since there are about 50 food groups and the average screen can display only 30 or so food groups at a
time in a drop down list box, there are 2 icons to facilitate your viewing of the food groups. By alternating
between these 2 icons, you can see the complete list of food groups in the drop down list box. You can
also select a food group by typing the first character of its name when this list box has the focus.

displays food groups in normal order in drop down list box.

displays food groups in reverse order in drop down list box.




Food groups

The food groups in the standard database are:

MILK, Milk Drinks

CREAM, Cream Substitutes

MILK DESSERTS, SAUCES, GRAVIES
CHEESES

BEEF

PORK

LAMB, VEAL, GAME

POULTRY

ORGAN MEATS

10. SAUSAGES, LUNCH MEATS

11. FISH, SHELLFISH

12. MIXED DISHES w/ sauce

13. MIXED DISHES w/ starch

14. MIXED DISHES w/ starch and vegetables
15. MIXED DISHES w/ vegetables

16. SANDWICHES
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17. FROZEN MEALS, w/ meat, poultry, fish base

18. EGGS, EGG PRODUCTS

19. LEGUMES

20. NUTS, SEEDS

21. BREADS (yeast), ROLLS, FLOUR
22. BREADS, QUICK

23. CAKES

24. COOKIES

25. PIES, PASTRIES

26. CRACKERS, SNACKS from grain products
27. PANCAKES, other grain products
28. PASTAS, COOKED CEREALS, RICE
29. CEREALS not cooked or NS

30. GRAIN MIXTURES DISHES

31. GRAIN MIXTURES, Frozen Meals
32. GRAIN MIXTURES, Soups

33. FRUITS, citrus, juices

34. FRUITS, dried

35. FRUITS, other

36. FRUIT JUICES, Nectars (non-citrus)
37. VEGETABLES, starchy

38. VEGETABLES, dark green

39. VEGETABLES, deep yellow

40. TOMATOES, tomato mixtures

41. VEGETABLES, other, raw

42. VEGETABLES, other, cooked

43. PICKLES, RELISHES, OLIVES

44. VEGETABLE SOUPS

45. VEGETABLES w/ meat, poultry, fish
46. FATS

47. OILS

48. SALAD DRESSINGS

49. SUGARS, SWEETS

50. BEVERAGES, non-alcoholic



51. BEVERAGES, alcoholic



Search mode

This is one of the most convenient features of NutriSoft programs. It allows you to find any particular food
items from the standard and user databases without your having to browse through different categories of
food groups.
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Search mode

When this mode is selected, an edit control is displayed in place of the Food Group combo box and 2
search icons are shown. You type in the name of the food item you want to find, for example "apple", then
click on one of the search icons. The list box will be filled with all food items containing "apple". You don't
need to type in a complete word: "app" will suffice. On the other hand, when there are too many matching
food items, you might want to restrict the match by specifying longer name such as "apple juice" or do a
local search after having the result of the global search. The search is not case sensitive: you can use
lower or upper case letters and this won't affect the result.

To exclude food items, use ! (the exclamation point) before the text string. Search on !spinach will
display all items that do not have 'spinach’ in their names.

The program will look for matching entries not only in the standard food database that comes with your
software but also in your own personal food database.

The matched food items displayed in the list box can be selected as those in any other mode.

In the registered version of the software, there is no restriction on the size of the user database on which
the search will be performed. However, memory limitation of your system might prevent the display of all
matched entries in the list box. In this case, a message box will appear to alert you of this situation.

In the shareware version, search will be performed on the abbreviated standard database and on the first
several records of the user database.

Global search: searches both the NutriSoft and user databases for a food item containing or not
containing a text string. On a 486-33 system, a global search takes just under 5 seconds.

Local search: searches only the listbox's content for food items containing or not containing a text string.
This is convenient for pruning down a previous search result which might contains hundreds of food
items.

Tip:
After entering the text to be searched, you can use Alt-G to do a global search or Alt-L to do a local
search without having to use the mouse to click on a search icon.



Personal Food Database

Occasionally you may not find a food item in the standard database. What do you do when you've just
eaten a serving of Haagen-Dazs ice cream? Or want to include a favorite ethnic TV dinner in your weekly
plan? Most of these items do have nutritional information on their packaging. NutriSoft program can
access and use their nutritional information once you've entered the data into your personal food
database. The registered version of the software does not set an upper limit on the number of food items
in the user's personal database.

Choosing Personal Food Database from the Options menu will display all food items from your database
in the list box. This mode is convenient when your diet consists mainly of special food items or when you
just want to browse the contents of your data.

See also Edit User Food Database



Edit User Food Database

The user food database is a file named 'userfood.txt'. The file can be edited using any plain text editor
such as the Windows notepad program. A NotePad icon is created for you during the installation of the
program to facilitate the editing of this file. You can also use a database program such as Access, FoxPro,
or Paradox, etc. or any spreadsheet program such as Excel or Lotus 1-2-3 to create this database and
export/save the database to/in the plain text format.

The format of each record (entry, line) in this database is:

- food name in double quotes (‘e.g., "Quarter Pounder with Cheese" )
- weight of 1 serving in grams (e.g., 184)

- calories from 1 serving in Kcalories (e.g., 560)

- protein from 1 serving in grams (e.g., 32)

- carbohydrate from 1 serving in grams (e.g., 37)

- total fat from 1 serving in grams (e.g., 30)

- calcium from 1 serving in milligrams (e.g., 206)

- iron from 1 serving in milligrams (e.g., 10)

Each food item must be stored on a single line and each nutrient information is separated from one
another by a comma so the above food item is recorded as:

"Quarter Pounder with Cheese", 184, 560, 32, 37, 30, 206, 10

Space(s) before or after the commas is optional.

Hint:
Please print out the file "'userfood.txt' for sample entries.



Serving amount

If necessary, you can adjust the amount consumed for a food item by typing the desired amount in grams
in the edit control above the 'Am(oun)t. OK' button. Once the right amount has been typed in, click on
'Amt. OK' to confirm and record this value.

For your convenience, we have provided 2 popup menus which you can use to quickly adjust the amount
of servings:

- a left mouse button click anywhere on the background of the document window will display a selection of
common serving sizes. If the serving size is 1 cup (the serving size or unit is enclosed in square brackets,
for example, [1 cup]), selecting .5 indicates that you consume half a cup of a particular food item. How
much half a cup weighs and the nutrient contents of this amount of food are adjusted and recorded
automatically for you. You can turn off this feature via the Options menu.

- a right mouse button click will display a selection of common servings in grams, ounces, or common
serving sizes. When you release the mouse button after selecting an amount, the amount in the edit box
and other data will be updated automatically. You can also choose the preferred input type via the Options
menu.



Quick Serving Entry in Ounces

This option allows you to hold down the right mouse button on the main window's background and select
one of the standard serving sizes in ounces for quick data input.



Quick Serving Entry in Grams

This option allows you to hold down the right mouse button on the main window's background and select
one of the standard serving sizes in grams for quick data input.



Quick Serving Entry in Common Serving Sizes

This option allows you to hold down the right mouse button on the main window's background and select
one of the standard serving sizes for quick data input.



Sorting:

You can quickly identify food items high or low in certain nutrients by sorting them. Since the nutrient
values are those contained in 100g of each food item, you can directly compare different items and easily
select the appropriate foods to meet your dietary requirement.

clicks this icon to sort the items in the listbox in ascending order. A selection menu will appear to let you
specify which particular nutrient you want to sort on.

clicks this icon to sort the food items in descending order.

indicates the food items are sorted in ascending order, click on a food item in the listbox to see the
nutrient's value.

indicates the food items are sorted in descending order, you can click on a food item to view the particular
nutrient's content.



Desirable Weight
This utility calculates the normal weight based on a person's height, sex and age.

If you are too fat or too thin, your chances of developing health problems are increased.

Being too fat is common in the United States. It is linked with high blood pressure, heart disease, stroke,
the most common type of diabetes, certain cancers, and other types of iliness.

Being too thin is a less common problem. It occurs with anorexia nervosa and is linked with osteoporosis
in women and greater risk of early death in both women and men.

Whether your weight is 'healthy' depends on how much of your weight is fat, where in the body the fat is
located, and whether you have weight-related medical problems, such as high blood pressure, or a family
history of such problems.

What is a healthy weight for you? There is no exact answer right now. Researchers are trying to develop
more precise ways to describe healthy weight. In the meantime, you can use this utility to help judge if
your weight is healthy. Find out if your weight is within the normal range. The range is higher for people
35 years or older than for younger adults. This is because recent research suggests that people can be a
little heavier as they grow older without added risk to health. Just how much heavier is not yet clear. The
weight ranges given by the utility are likely to change based on research under way. The current data are
derived from Diet and Health (National Research Council, 1989).

Ranges of weight are given by this utility because people of the same height may have equal amounts of
body fat but differ in muscle and bone. The higher weights in the ranges are for people with more muscle
and bone.

Weights above the range are believed to be unhealthy for most people. Weights slightly below the range
may be healthy for some small-boned people but are sometimes linked to health problems, especially if
sudden weight loss has occurred.

Please consult with your doctor to find out what is the optimal weight for you. Because individuals differ,
your optimal weight may be lower or higher than the normal range.

Use the spin controls in the dialog box to specify your height (without shoes). Specify your sex and age by
selecting the appropriate radio buttons.
To plan your weight loss use Weight Control Plan.

If you close the dialog box by clicking the OK button, the information will be saved and redisplayed next
time you invoke the dialog box. Use the Esc key to close the dialog box without saving.



Set Fat Warning Level

"Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake."
U.S. Surgeon General

Is this food too fatty? Use this dialog box to set the threshold when the program should warn you when a
food item exceeds the limit. A green or red symbol is displayed appropriately. You can click on the symbol
to invoke the dialog box.

When you print out your nutritional analysis of your diet, each fatty food will also be marked with an
asterisk for easy recognition.



Caloric Need and Nutrient Requirements

This dialog box calculates your daily caloric need and recommended intakes of important nutrients
according to your age, ideal weight, activity level.

Specify your age, ideal weight and activity level using the spin buttons. Activity level ranges from 1
(sedentary) to 10 (strenuous).

Suggested total fat intake is based on the American Heart Association's and the Food and Nutrition
Board's recommendation that no more than 30% of your calories come from fat.

Recommended intakes of other nutrients are based on the Surgeon General's recommendation and on
the National Research Council's data.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit
Esc. If you click OK, the current information is saved for next time you invoke the dialog box.

The dialog box must be filled out at least once: when you run the application for the first time, the dialog
box is automatically presented to obtain your individual information. You can revise the information
anytime.



Weight Control Plan

It's hard to achieve your weight goal without planning. This utility allows you to establish a plan and
estimate precisely how much weight you will gain or lose when you follow this plan.

First, please specify your current weight and activity level by clicking on the appropriate spin controls. The
activity levels range from 1 (for those having sedentary lifestyle) to 10 (for those having physically
strenuous occupations). The dialog box displays the number of calories required for you to maintain your
current weight.

The 'Daily consumption' list box (on the right) should contain several files for you to add to your plan (the
list box on the left). Please note that you must have previously saved some files before you can use this
dialog box. Or you can try out the sample daily food consumption files we provide.

Let's assume you've prepared 7 daily menus and name them Sun, Mon, Tue, etc. [The program
automatically adds in the standard extension for your files, please use the standard extension.] These
files should appear on the right hand side list box. You add the files one by one to your plan by selecting
them then click on the 'Add to Plan' button or by double-clicking the file names.

As you add in these files, the dialog box automatically calculate the amount of weight you should gain or
lose if you follow your plan, the average daily caloric intake and the average fat content of your plan.

NutriSoft weight control plan is truly flexible: you can set a food plan to be repeat every week, every 3
days or every 10. You can also anticipate your future weight when your plan is repeated during this period
by adjusting the number of days in the period via the spin control.

Once an entry is added into your plan, you can select it then click on the 'chart' button to review its
nutritional content.

In general, you should not try to achieve significant weight loss in just a few days. Please consult your
physician regarding your weight loss goal. Even an energy deficit of just 500 kcal a day should result in a
loss of approximately 1 pound per week or 50 pounds a year!

After setting up your plan, print out a report to keep track of your food intake and to motivate yourself to
achieve your goal.



Nutrient Analysis

Do you know which meal provides you with the most protein in your diet? With the most fat? This graph
displays the percentage of each nutrient consumed during each meal of the day.

Select 'Protein' from the combo box and the graph shows the percentage of protein that comes from
breakfast, morning snack, lunch, afternoon snack, dinner and evening snack in counter clockwise order.

The analyses are provided for weight, calories, protein, carbohydrate, fat, and other essential nutrients
when available. These analyses are very convenient when you want to spread out your energy intake
throughout the day instead of concentrate your food consumption in infrequent big meals.

To leave the dialog box, click on the OK button or select Close from the dialog box's system menu or hit
Esc. If you click OK, the currently selected nutrient will also be initially selected next time you invoke the
dialog box.



Caloric Analysis

These 2 graphs provide information about the nutrient contents of your food intake for the current day or
for that previously saved in a file.

The left graph shows the weight in grams of protein, carbohydrate and fat in the day's food consumption.
The right graph shows the day's caloric intake and a pie chart depicting the percentages of calories from
protein, carbohydrate and fat in counter clockwise order. Each nutrient is color coded for easy
identification.

You should pay particular attention to the percentage of calories from fat. The American Heart Association
recommends that your total fat intake be no more than 30 percent of your total calories.

To leave the graphs click the mouse anywhere inside them or hit the escape key.



Set Fat Warning Level

This option allows you to specify the percentage of calories from fat above which you want to be alerted.
For example, if you want to identify foods that has more than 50% of their calories derived from fat, you
should set this value through the Set Fat Warning Level dialog box. From then on, each time a food item
is consumed, a green or red symbol will be displayed to indicate whether its fat content is below or above

the limit you set. When you print out your nutritional report, each food item exceeding this limit is also
flagged with an asterisk before its name.

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.




Set Nutrient Intake Preference

How much of each nutrient do you want to consume each day? Use this dialog box to set your own
preference. The color of the RDA analysis bars will reflect your preference. The bars are green when you
consumption is within your preferred range, yellow when you are not having enough of a nutrient,
magenta when your intake is somewhat above the optimal range, and red when the consumption is
considerably higher than desired.

Click on the Use RDA button if you want the Recommended Dietary Allowance value for any particular
nutrient. Please note that the RDA values are for an average individual. You might need to adjust your
optimal intake accordingly.



Caloric Analysis

Do you need a more healthful diet? This menu item displays a graph showing the number of calories in
your diet that comes from protein, carbohydrate or fat.



Nutrient Analysis

Are you eating too much at dinner and not enough at breakfast? Check out the relative nutrient intakes of
all your daily meals.



Weight Control Plan

It is now so easy to establish a sensible plan to control your weight. Your plan can be set for any number
of days. Find out how much weight you will gain or lose in a week, a month or a year; and whether you
are consuming too much fat in your plan.



Caloric Need

Find out how many calories you need a day based on your age, desirable weight and activity level. The
dialog box also shows the maximum recommended fat consumption in your diet.



Desirable Weight

This menu item displays a dialog box which allows you to determine your ideal weight based on your sex,
height and body frame.



Find Food Item with Lowest Content of a Nutrient

=l

Click this button to search for food item in your day consumption that has the lowest amount of a
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is
useful when you want to keep the consumption of a particular nutrient low. For example, you can find food
items with lowest fat content and consume more of these items without worrying about quickly increasing
your fat intake. If your day's consumption has several items with the same low fat content in different
meals, the program cycles through these items each time you click on this button.



Find Food Item with Highest Content of a Nutrient

1

Click this button to search for food item in your day consumption that has the highest amount of a
particular nutrient. The food item is highlighted and the meal where it is consumed is selected. This is
very useful when you want to quickly lower or raise the consumption of a nutrient. For example, your day
consumption is too high in fat. You can use this button to identify the food item that most contributes to the
high fat content and adjust your consumption of this item accordingly.



Choose Printer Font

Use this option to select the printer font for your Nutritional Analysis Report and Weight Planning Report.



Choose Screen Color

Some monitors flicker noticeably when certain colors are displayed. Use this option to select the most
pleasing color for your screen background.



Body Mass Index

Are you thin, or are you overweight? This dialog box uses the Body Mass Index (BMI) which is derived
from your height (without shoes) and weight (without clothes) to chart your precise standing. Compare
your BMI with that of an average person, or an obese individual.



Caloric Expenditure of Common Activities

This utility allows you to calculate how many calories you burn by exercising or by doing many of the
usual daily activities. The registered database contains information on 130 common activities. You should
select an activity and set it (via the 'Set Favorite Activity' button) as your favorite activity. Once this has
been set, each time you consume a food item, its caloric equivalence in terms of your favorite activity is
calculated and displayed on the status bar at the bottom of your screen. For example, you set Tennis as
your favorite activity and you weigh 160 Ibs.; when you drink a cup of milk, the caloric equivalence of this
food item is 18 minutes of Tennis. This means it takes you 18 minutes of playing tennis to burn away the
calories contained in one cup of milk!

Another interesting piece of information the Caloric Expenditure dialog box provides is how much exercise
it takes to lose one pound of weight. Let's say you weigh 155 Ibs. and usually play tennis for an hour each
time you get to play. The dialog box figures out you need to repeat this activity (an hour of tennis) 7 times
to burn away one pound of weight, everything else being equal. Please note that this is not an advice for
you to go out and play tennis 7 times to achieve this weight reduction! The information is presented so
that you can have another measure of the relationship between weight loss and physical exercise. Before
embarking on any exercise program, you should obtain approval from your doctor.



Show CSI

This option, available in Lower Your Cholesterol, toggles the display of the Cholesterol Saturated Fat
Index.



Reverse Food Groups

This command reverse the current display order of the food group names in the Food Group drop down
list box.



Left Mouse Button

This option toggle the quick input mode of the left mouse button.



Food Guide Pyramid

This dialog box displays the Food Guide Pyramid analysis of your current diet. If your diet is balanced and
varied, the result should resemble a well-formed pyramid where the base is larger than the top.

The USDA recommended number of servings is for an average individual; you may want to consult with
your doctor to design an optimal personal diet program. The RDA and caloric counters of this program
can also serve as a guide.

To arrive at your ideal weight, you may need to change your current approach to eating. Permanent
weight loss is most easily achieved with a varied, balanced and nutritious diet that is low in fat and in
empty calories. Use this Pyramid Food Analysis to help you identify imbalanced or restrictive diet.

Please note that you can add your own favorite foods to the user's food database and specify a food
group for each of these foods. The registered version of this software does not set a limit on the number
of entries in the user's food database.

Note: This feature is available only in the following program:
NutriSoft Pyramid Weight Loss Diet



Target Heart Rate

This utility helps you determine if your heart is fit. During your next workout, take a break from your
routine and take your pulse for 10 seconds to measure the intensity of your workout. Refer to the dialog
box: if this number is within your Target Heart Rate then you are heart fit and your workout is efficient.
When exercise, you should aim for your Target Heart Rate because you will get the maximum benefit
from your exercise.

Your heart rate typically has a maximum value according to your age. This means your heart doesn't beat
faster than this rate no matter how strenuously you exercise. Normally, you should try to reach from 65 to
85% of this heart rate from your exercise. Below this range, you are not exercising hard enough; above i,
you might want to take it easy while working out. The 85% maximum heart rate is for athlete in training.

User over 40 years old or those with heart problem should definitely consult with their doctors and have a
stress electrocardiogram performed before adopting any exercise program.



Weight Tracker

This utility allows you to keep track of your weight loss progress over time. It can accommodate many
users and although its primary purpose is for weight tracking, you can use its graphing and convenient
data entry capabilities to keep track of other information too.

Begin by creating a log for yourself using your name, for example. Once a user's log has been created,
you type in the initial weight in the weight recording edit control. Afterwards, the easiest way for data entry
is to click and drag the mouse on the background of the dialog box to select the desired weight. Make
sure you save or click OK before closing the dialog box to retain the data for next time. Or hit 'esc(ape)' to
cancel the data entry. Normally you enter the data weekly. You can also enter the data every few days.
Please just make sure that the data are entered regularly enough so that the shape of the graph
accurately reflects your progress.



Diet Tracker

This utility allows you to keep track of your diet over time. You can keep track of the diet for many users
using this dialog box. Make sure you save or use the OK button to save the data when exit. Select one of

the files in the combo-box and add it to your diet log.



Average Caloric Content of Diet

What is important is not a single day's diet but your cumulative diet. This dialog box shows you the
average caloric content of your diet that comes from each of the following nutrients: fat, carbohydrate and
protein; a relative percentage value is also given. The percentages may not add up to exactly 100%
because of truncation.



Dialog Boxes
Please note that some special dialog boxes (marked with *) are not available in this program.

Food Pyramid Analysis*
Set Fat Warning Level

Establish Weight Reduction Plan
Choose Screen Color

Choose Printer Font

Set Nutrient Intake Preference

Find Desirable Weight

Find Caloric and Nutrient Requirements
Caloric Analysis

Nutrient Analysis

Body Mass Index

Caloric Expenditure

Weight Tracker

Diet Tracker

Target Heart Rate



Glossary

Atherosclerosis: A type of "hardening of the arteries" in which cholesterol, fat, and other blood
components build up in the walls of arteries. As atherosclerosis progresses, the arteries to the heart may
narrow so that oxygen-rich blood and nutrients have difficulty reaching the heart.

Carbohydrate: One of the three nutrients that supply calories (energy) to the body. Carbohydrate
provides 4 calories per gram -- the same number of calories as pure protein and less than half the
calories of fat. Carbohydrate is essential for normal body function. There are two basic kinds of
carbohydrate -- simple carbohydrate (or sugars) and complex carbohydrate (starches and fiber). In
nature, both the simple sugars and the complex starches come packaged in foods like oranges, apples,
corn, wheat, and milk. Refined or processed carbohydrates are found in cookies, cakes, and pies, etc.

Cholesterol: A soft, waxy substance. It is made in sufficient quantity by the body for normal body
function, including the manufacture of hormones, bile acid, and vitamin D. It is present in all parts of the
body, including the nervous system, muscle, skin, liver, intestines, heart, etc.

Blood cholesterol--Cholesterol that is manufactured in the liver and absorbed from the food you eat
and is carried in the blood for use by all parts of the body. A high level of blood cholesterol leads to
atherosclerosis and coronary heart disease.

Dietary cholesterol--Cholesterol that is in the food you eat. It is present only in foods of animal
origin, not in foods of plant origin. Dietary cholesterol, like dietary saturated fat, tends to raise blood
cholesterol, which increases the risk for heart disease.

Coronary heart disease: Heart ailment caused by narrowing of the coronary arteries (arteries that supply
oxygen and nutrients directly to the heart muscle). Coronary heart disease is caused by atherosclerosis,
which decreases the blood supply to the heart muscle. The inadequate supply of oxygen-rich blood and
nutrients damages the heart muscle and can lead to chest pain, heart attack, and death.

Fat: One of the three nutrients that supply calories to the body. Fat provides 9 calories per gram, more
than twice the number provided by carbohydrate or protein. In addition to providing calories, fat helps in
the absorption of certain vitamins. Small amount of fat are necessary for normal body function.

Total fat: The sum of saturated, monounsaturated, and polyunsaturated fats present in food. A mixture of
all three in varying amounts is found in most foods.

Gram: A unit of weight. There are about 28 grams in 1 ounce. Dietary fat, protein, and carbohydrate are
measured in grams.

Lipids: Fatty substances, including cholesterol and triglycerides, that are present in blood and body
tissues.

Lipoproteins: Protein-coated packages that carry fat and cholesterol through the blood. Lipoproteins are
classified according to their density.

High density lipoproteins (HDL)--Lipoproteins that contain a small amount of cholesterol and carry
cholesterol away from body cells and tissues to the liver for excretion from the body. Low levels of
HDL are associated with an increased risk of coronary heart disease. Therefore, the higher the HDL
level, the better.

Low density lipoproteins (LDL)--Lipoproteins that contain the largest amount of cholesterol in the
blood. LDL is responsible for depositing cholesterol in the artery walls. High levels of LDL are
associated with an increased risk of coronary heart disease and are therefore referred to as "bad



cholesterol".

Osteoporosis: a condition in which the calcium content of the bones is depleted over time such that the
bones become brittle and can be fractured with even minimal trauma.

Protein: One of the three nutrients that supply calories to the body. Protein provides 4 calories per gram,
which is less than half the calories of fat. Protein is an essential nutrient that becomes a component of
many parts of the body, including muscle, bone, skin, and blood.

Recommended Dietary Allowances (RDAs): the levels of intake of essential nutrients that, on the basis
of scientific knowledge, are judged by the Food and Nutrition Board to be adequate to meet the known
nutrient needs of practically all healthy persons. [Individuals with special nutritional needs are not covered
by the RDAs.]

Triglycerides: Lipids (fat-like substances) carried through the bloodstream to the tissues. The bulk of the
body's fat tissue is in the form of triglycerides, stored for later use as energy. We get triglycerides primarily
from the fat in our diet.

Vascular disease: An ailment of the blood vessels often caused by atherosclerosis. Vascular disease
may occur in the arteries to the brain and the major leg arteries.



Questions and Answers

Q. What are the benefits of registering this software?

A.

1. Registered users receive an upgraded diskette having an expanded food database. Some registered
products have printed guides or manuals.

2. The registered version of the software processes all food items in the user's personal database. In the
shareware version, you can prepare as large a personal food database as you have data for but the
program makes use of (sorts, searches or displays) only the first several entries in this database.

3. In addition to free technical support, registered users receive deep discount on future registrations of
NutriSoft products. Fee for upgrading to later version of the same program is also minimal.

Q. How can | register for NutriSoft software?
A. You can register by mail, by phone using credit card, or through the CompuServe Shareware
Registration Service. Please see the registration topic for more information.

Q. Which NutriSoft program is best for me?

A. You may want to use the following steps to select the software:

1.  select the program that analyzes all the nutrients and has all the features you require, if there is
more than one

2.  select the program that has the larger food database, then

3.  select the program that has the later version number, then

4.  select the program that costs less.

Q. How much does it cost to upgrade to newer versions of NutriSoft products?

A. Registered users automatically receive a free upgrade when there is a minor revision of a product.
When there is a major new release, the standard upgrade cost is 20% of the registration fee. For
example, registered users of Weight Perfect 2.0 can upgrade to Weight Perfect 3.0 for $7 which is 20% of
the $35 registration fee of this product.

Q. Is there printed manual for this product?

A. Because of frequent updates to our programs, in general, we provide only on-line documentation: this
help file. While reading this help file you can print out any topic as needed via the 'Print topic' command
from the 'File' pull-down menu.

Starting with version 3.4 or later, some of our products have printed nutrition guides or manuals. Please
refer to the program specific section in this help file for this information.

Q. Where can | obtain other NutriSoft shareware products for evaluation?
A. We encourage you to obtain other NutriSoft products from your current shareware distributor or BBS. A
complete selection of our software can also be downloaded from:
1. CompusServe: the Windows Shareware Forum, Holistic Health Forum (GO HOLISTIC), and Health
and Fitness Forum (please search on contributor: 71563,124)
2. America Online: the Windows Forum (please search on keyword: NutriSoft)
3. Internet FTP: ftp.cica.indiana.edu, the Center for Innovative Computer Applications ftp site of
Indiana University. Our files are in directory pub/pc/win3/misc (please search on file names starting
with "ns"). Another ftp site which has our latest programs is oak.oakland.edu (directory
SimTel/win3/food).



About NutriSoft

NutriSoft was established by a group of Stanford University researchers to provide consumers with quality
software to help them achieve better health. Your suggestions and comments on our products are much
appreciated. Please write to us at the following addresses:

US Mail: P.O. Box 8226, Stanford, CA 94309

America Online: NutriSoft

CompuServe; 71563,124

Internet: NutriSoft@aol.com or 71563.124@compuserve.com

We welcome inquiry from authors, institutions, and publishers who would like to distribute our products or
customize our software to use with their own nutritional data. We also license our technology (including
source code) and provide technical consulting services to other nutrition software companies.

List of software products released by NutriSoft as of January, 1995:

1. Fat and Cholesterol Counter for Windows v. 1.1 ($19)
This program is a perfect companion to American Heart Association's Fat and Cholesterol Counter, a
guide for everyone who wants a more healthful diet.

2. NutriSoft Pregnancy Nutrition for Windows v. 2.1 ($39)
The program, developed from the latest findings of the American Academy of Pediatrics and the National
Academy of Sciences, is the best nutrition software for a mother's health and that of her child.

3. NutriSoft Healthy Heart Nutrition for Windows v. 3.5 ($35)
The most effective dietary strategy to reduce heart disease risk.

4. NutriSoft Reduce Cancer Risk for Windows v. 3.0 ($39)
Based on studies of the National Cancer Institute and US Surgeon General's dietary guidelines, this
program can help you lower the risk of cancer from diet.

5. NutriSoft Weight Perfect for Windows v. 3.0 ($35)
Indispensable to anyone who wants to achieve a more desirable weight. Has large food database of
approximately 10,000 items.

6. NutriSoft High Blood Pressure Nutrition for Windows v. 3.2 ($39)
The program is based on the report of the Joint National Committee on Detection, Evaluation, and
Treatment of High Blood Pressure. An excellent nondrug approach to treatment for and prevention of high
blood pressure.

7. NutriSoft Lower Your Cholesterol for Windows v. 3.2 ($39)
More than half of all adult Americans have a blood cholesterol level that is higher than desirable. This
program helps you conform to the cholesterol-lowering dietary guidelines of the National Cholesterol
Education Program and National Heart, Lung, and Blood Institute.

8. NutriSoft Diabetic Nutrition for Windows v. 3.3 ($39)
Essential tool for accurate monitoring of diabetic diet. Includes sugar analysis of common foods and
weight control planner.
[ Registered users of Control Diabetes version 1.2 can purchase this program for $19. ]

9. NutriSoft Pyramid Weight Loss Diet for Windows v. 3.4 ($29)
The program analyzes user's weight control diet for conformance with the USDA Food Guide Pyramid in
addition to the National Research Council's RDAs. Has standard database of approximately 1,000 most



commonly used food items.

10. NutriSoft Nutrition for Women for Windows
A complete nutrition guide for women of all ages.

11. NutriSoft Sugar Content of Foods for Windows

12. NutriSoft Omega-3 Counter for Windows

v. 3.5 ($39)

v. 3.3 ($19)

V. 3.4 ($19)



Registration Form

[This form can be printed by selecting 'Print topic' from the File pull-down menu.]

Please indicate which software product(s):

1. Fat and Cholesterol Counter for Windows v.1.1  ($19)
2. NutriSoft Diabetic Nutrition for Windows v.3.3  ($39)
3. NutriSoft Weight Perfect for Windows v.3.0 ($35)
4. NutriSoft Pregnancy Nutrition for Windows v.2.1  ($39)
5. NutriSoft High Blood Pressure Nutrition for Windows v.3.2  ($39)
6. NutriSoft Healthy Heart Nutrition for Windows v.3.5 ($35)
7. NutriSoft Reduce Cancer Risk for Windows v.3.0 ($39)
8. NutriSoft Lower Your Cholesterol for Windows v.3.2 ($39)
9. NutriSoft Pyramid Weight Loss Diet for Windows v.3.4  ($29)
10. NutriSoft Sugar Content of Foods for Windows v.3.3 ($19)
11. NutriSoft Omega-3 Counter for Windows v.3.4 ($19)
12. NutriSoft Nutrition for Women for Windows v.3.5 ($39)

Name:

Address:

City: State: Zip:

How did you obtain this NutriSoft shareware?

Your email address, if available:

Please send check or money order to
NutriSoft
P.O. Box 8226
Stanford, CA 94309

International order: please remit in U.S. currency and add $1 for airmail postage. Because of high
processing fee from our bank, we can no longer accept personal check from a non-US bank. Please use
money order from your bank, local American Express office, or postal money order. CompuServe users

should use the CIS Shareware Registration Service.

See also Registration by Credit Card



Registration via CompuServe

Members of CompuServe can register for any NutriSoft products through its Shareware Registration
Service (GO SWREG).

Please search for our products using "NutriSoft" as keyword. You can also specify a particular filename if
the search fails to list all of our software products.

After you complete the CompuServe registration process, we will be notified and the upgraded registered
software diskette(s) will be sent to you within 24 hours.

See also Registration by Credit Card



Registration by credit card

[This page can be printed by selecting 'Print topic' from the File pull-down menu.]

Credit card users can register for any NutriSoft products through the PsL (Public software Library)
Registration Service.

Please call 1 - 800 - 2424 - PsL ( 1-800-242-4775 ) or 713-524-6394

PsL Registration Service can also be reached

by FAX (713) 524-6398

by CIS Email 71355,470

by Internet Email  71355.470@compuserve.com

by mail P.0.Box 35705, Houston, TX 77235-5705.

Please note the above phone numbers and addresses are for registration by credit card only. Any
questions about the status of the shipment of the order, product details, technical support, volume
discounts, dealer pricing, site licenses, etc., must be directed to NutriSoft. You get quickest answers by

sending email directly to NutriSoft.

To insure that you get the latest version, PsL will notify NutriSoft the day of your order and NutriSoft will
ship the product directly to you.

List of NutriSoft products that can be registered through the PsL Registration Service:
(please mention the number preceding the program name: its PsL registration ID)

1) 11551 Fat and Cholesterol Counter for Windows v. 1.1
2) 11553 NutriSoft Weight Perfect for Windows v. 3.0
3) 11554 NutriSoft Pregnancy Nutrition for Windows v. 2.1
4) 11690 NutriSoft Healthy Heart Nutrition for Windows v. 3.5
5) 11557 NutriSoft Reduce Cancer Risk for Windows v. 3.0
6) 11558 NutriSoft Lower Your Cholesterol for Windows v. 3.2

7) 11582 NutriSoft High Blood Pressure Nutrition for Windows  v. 3.2

8) 11583 NutriSoft Diabetic Nutrition for Windows v. 3.3
9) 11689 NutriSoft Pyramid Weight Loss Diet for Windows v. 3.4
10) 11755 NutriSoft Nutrition for Women for Windows v. 3.5

See also Registration via CompuServe



Determining Activity Levels

The activity levels used in NutriSoft programs range from 1 to 10.
Level 1 corresponds to the resting state with little or no activity.

Levels 2 to 4 corresponds to a sedentary lifestyle where a 150-Ibs individual would burn between 80 and
150 Calories an hour. Please refer to the Caloric Expenditure dialog box. Users who do mostly office
work, light housework, or driving, etc., belong to this category.

Levels 5 to 7 are for those with moderately active lifestyle. If you are an office worker but play tennis or
bike ride an hour or 2 a day; or your profession demands physical activities similar to those of carpenters,
plasterers, etc. then you belong to this category.

Levels 8 to 10 are for very active individuals such as athletes, those who regularly do strenuous tasks
such as shoveling, weight lifting, etc.



Cholesterol Profile

This utility compares your cholesterol levels (total cholesterol, LDL cholesterol, HDL cholesterol and
triglyceride) with those of the general population. There are 4 bars in each graph, the first bar indicates
the lowest quartile (the lowest 25% of the population have cholesterol below this value), the second bar is
the average value of the population, the third bar shows the highest quartile (the top 25% of the
population have their cholesterol level above this value) and the last bar is your own level.

Select your age group, your sex and use the spin controls to set your own cholesterol levels. The utility
will adjust the graphs and indicate whether your level of a particular cholesterol is desirable, borderline
high, or high, etc. These categories are defined by the National Institutes of Health's Adult Treatment
Panel. Sometimes, LDL cholesterol is not measured directly in your test. In this case, you can tell the
utility to estimate your LDL cholesterol from your total cholesterol, HDL cholesterol and triglyceride.

Your heart disease risk is categorized based on the ratio of your total cholesterol over your HDL
cholesterol.

The 'Save' button will close the dialog and saves your personal values for future retrieval.
This utility is available in the following programs: Lower Your Cholesterol and Diabetic Nutrition.



NutriSoft "Nutrition for Women" Help Index

General Information
Introduction
Dietary Guidelines
About "Nutrition for Women"
Main Uses of "Nutrition for Women"
Basic Operations
NutriSoft food databases
Program's icons and buttons [Please read this topic.]
Dialog boxes
New Features
Glossary
Questions and Answers
About NutriSoft

Registration
Registration Form
Registration via CompuServe

Registration using credit card
Disclaimer

Commands
File menu
View menu
Tools menu

Options menu
Window menu

Help menu

You can obtain specific help for the current task by pressing F1 at any window or dialog box.
To obtain a hard-copy of a help topic, choose 'Print topic' from the File pull-down menu.



Program's Icons and Buttons

This is a comprehensive list of shortcuts via icons and buttons to all NutriSoft utilities, some icons may not
be accessible in this program because their utilities are not available. If an icon is not described in this list,
you can obtain its description via the context-sensitive help button (the last button) on the application
toolbar.

Pyramid analysis:
brings up a dialog box which uses the USDA Food Guide Pyramid to analyze your diet.

Fat content:

indicates food item does not exceed user-specified percentage of calories from fat.

indicates food item exceeds user-specified percentage of calories from fat.

Click on either of these icons to specify the fat percentage where you want to be warned when exceeded.
Caloric analysis:

Ll

clicks this icon to see graphic analysis of calories from fat, protein and carbohydrate for selected food
item.

Sorting:
Nutrients are sorted based on values in 100g of food.

o
)
Q

s this icon to sort the items in the listbox in ascending order.

Q
o
QL

s this icon to sort the food items in descending order.

indicates the food items are sorted in ascending order, click on a food item in the listbox to see the
nutrient's value.

[ ]
indicates the food items are sorted in descending order.

Food groups viewing:

Since there can be more than 50 food groups in our database and an average screen can display only
about 30 food groups at a time, these buttons make it more convenient to view the food groups (when you
hold down the mouse on the drop down listbox) by displaying them in normal order (first group first) or
reverse order (last group first). You can select a food group by the mouse or by typing in the first letter of



the food group's name.

displays food groups in normal order in drop down list box. Instead of clicking on this icon, you can use
alt-n (Normal).

displays food groups in reverse order in drop down list box. Instead of clicking on this icon, you can use
alt-r (Reverse).

indicates food groups are displayed in normal order.

indicates food groups are displayed in reverse order.

Searching:

Since there can be up to approximately 10,000 food items in our food database in addition to other items
in user's database, this search facility makes it easy for you to locate any particular food by name. [Some
of our programs come with a standard database of about 1,000 food items. Please see the readme.txt file
for the database size of a particular program.] You can do a global or a local search. You can specify that
the result include or exclude certain food items.

Example: to find all foods containing 'yogurt', you type this string (without the quotes) into the edit control
and click the global search icon. [If you don't see the search icons, you need to select Options then
Search mode from the main menu first.] The result is displayed in the listbox below when the search is
completed. To exclude all vanilla yogurt, you type the string 'lvanilla’ (without the quotes) into the edit
control and click the local search icon. [Don't leave a space before your search text or after the
exclamation point because blank space is significant in the search.] To narrow the result further, you can
do another local search on the non-vanilla yogurt items; or you can proceed to another global search.

Q|

Enter search mode

Global search: searches both the NutriSoft and user databases for a food item containing or not
containing a text string. You can use alt-g (Global) instead of clicking on this icon.

Local search: searches only the listbox's content for food items containing or not containing a text string.
This is convenient for pruning down a previous search result which might contains hundreds of food
items. You can use alt-l (Local) instead of clicking on this icon.

Quick Find:
If your current day's diet is too high in fat, for example, you can use this feature to quickly locate the item
most contribute to this problem and adjust your consumption accordingly.

| 1

locates the food item in the current day's consumption that has the highest content of a particular nutrient.

=

locates the food item in the current day's consumption that has the lowest content of a particular nutrient.






View menu commands

The View menu offers the following commands:

Caloric Analysis Shows graphic analysis of percentage of calories from protein,
carbohydrate and fat.

Nutrient Analysis Shows graphic analysis of the individual nutrient contents from your
daily food consumption.

Toolbar Shows or hides the toolbar.

Status Bar Shows or hides the status bar.

Tools menu commands

The Tools menu offers the following commands:

Cholesterol Profile Analyze your blood cholesterol levels and your heart disease risk

Weight Control Plan Use this dialog box to set short and long-term plan for weight
control.

Desirable Weight Determine your ideal weight based on your sex, height and body
frame.

Body Mass Index Compare your body mass index with the general population's

Caloric Need Find out your daily caloric need.

Caloric Expenditure Find out how much energy is used in common activities



Options menu commands

The Options menu offers the following commands:

Search Mode Allow you to search for any specific food from the
standard and personal food databases.

Food Groups Mode Display food items according to food groups.

Personal Food Database Display food items from your personal food
database.

Show CSI Toggle the display of Cholesterol Saturated Fat
Index

Reverse Food Groups Reverse the display order of food group names

Choose Printer Font Select your favorite printer font for your nutritional
and weight planning report.

Choose Screen Color Select your favorite color for your screen
background.

Set Nutrient Intake Preference Set your preferred ranges of nutrient intakes. The
color of the RDA analysis bars will reflect your
preference.

Set Fat Warning Level Set threshold beyond which you are alerted when

a food item has more than certain percentage of
calories from fat.

Left Mouse Button Quick Input Toggle the use of left mouse button for quick
serving input

Right Button: Gram Quick Input Hold down the right mouse button on the window

Mode background will display serving amount in grams
for quick selection.

Right Button: Ounce Quick Input  Hold down the right mouse button on the window

Mode background will display serving amount in ounces
for quick selection.

Right Button: Serving Quick Hold down the right mouse button on the window

Input Mode background will display common serving sizes for

quick selection.



Obesity

Excess weight or overweight occurs when too few calories are expended and too many consumed for
individual metabolic requirements. If you eat more than you need, the surplus energy is stored in your
body as fat. When the amount of your body fat is excessive and unsightly, you are overweight. More
specifically, if your weight exceeds the desirable weight by 20% or more, you are considered obese. The
extraordinarily high prevalence of obesity in the United States -- one-fourth of American adults are
overweight and nearly one-tenth are severely overweight -- coupled with its role as a risk factor for
diabetes, hypertension, coronary artery disease and stroke, gallbladder disease, and some types of
cancer, suggests that a reduction in the average weight of the general population would improve the
Nation's health.

Americans, in general, would benefit from a lifestyle that includes more physical activity and a diet
containing fewer calories and less fat.

Treatment of Obesity

To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both. Thus, the chief
approaches to weight reduction involve behavior change related to diet and exercise, drugs to decrease
hunger or increase satiety, and surgical or mechanical intervention designed to reduce food intake.

Thus far, no drug therapy has induced long-term weight loss. Drugs are aimed at decreasing hunger or
increasing satiety, usually by mimicking certain neurotransmitters or hormones that play a physiologic role
in feeding behavior. One problem is that weight lost with drug therapy is more often regained than with
other methods, suggesting that appetite-suppressant drugs lower the set point level at which body weight
is regulated and only secondarily suppress appetite. Regardless, weight loss would be expected to occur
only during the period of drug therapy, suggesting the need for chronic treatment.

Surgical intervention appears appropriate only for selected persons with massive obesity or with its
severe complications who have not responded to more conservative treatment. Jejunoileal bypass has
been largely abandoned because of unfavorable side effects. Other procedures such as gastric balloons
and gastric surgery, which reportedly cause substantial weight loss -- although rarely to ideal weight -- in
morbidly obese persons, require further study before their long-term effects are known.

Weight loss reduces health risks in the obese. A combination of diet and exercise seems to be the most
sensible approach to treatment. However, fad weight loss regimens of unscientific merit have been
estimated, in 1981, to cost consumers $5 billion annually. While such diets attract many people's attention
they may be dangerous, especially when they provide less than the full complement of essential nutrients.

NutriSoft program is based on the US Surgeon General's Report on Nutrition and Health and dietary
guidelines for weight reduction and prevention of obesity. It is an excellent tool to help you analyze your
food intake and obtain a more desirable weight. This program allows you to enjoy varied, balanced,
flexible, healthful and pleasant meals while you are on a weight loss diet. The program can be used by
itself, or in conjunction with diet programs from your favorite authors. Whether you are vegetarian, or
follow a macrobiotic diet, or enroll in a weight-loss club, etc., you will find that our software gives you
better insight into your diet and helps you make informed dietary decisions.

"Four of the six leading causes of death

-- diabetes, heart disease, cancer and obesity -- are related to nutrition
... [but] many doctors don’'t ask questions about diet

until the patient has a heart attack.”

Dr. Steve Zeisel,

Chairman, Nutrition Department, University of North Carolina

(Associated Press)






File menu commands

The File menu offers the following commands:

New Creates a new document.

Open Opens an existing document.

Close Closes an opened document.

Save Saves an opened document using the same file name.
Save As Saves an opened document to a specified file name.
Print Prints a document.

Print Setup Selects a printer and printer connection.

Exit Exits program.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple views of multiple
documents in the application window:

Cascade Arranges windows in an overlapped fashion.
Tile Arranges windows in non-overlapped tiles.
Arrange Icons Arranges icons of closed windows.
Window 1, 2, ... Goes to specified window.




Help menu commands

The Help menu offers the following commands, which provide you assistance with this application:

Index Offers you an index to topics on which you can get help.
Using Provides general instructions on using help.
Help

About Displays the version number of this application.



New command (File menu)

Use this command to create a new document (file) in "Reduce Cancer Risk". A document (file) contains all
the information regarding the foods you consume during a day. You can open an existing document with

the Open command.

Shortcuts

Toolbar:

Keys: CTRL+N



Open command (File menu)

Use this command to open an existing document in a new window. You can open multiple documents at
once. Use the Window menu to switch among the multiple open documents. See Window 1, 2, ...
command.

You can create new documents with the New command.

Shortcuts

Toolbar:

Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name
Type or select the filename you want to open. This box lists files with the extension you select in the
List Files of Type box.
List Files of Type
Select the type of file you want to open.
Drives
Select the drive in which "Reduce Cancer Risk" stores the file that you want to open.

Directories
Select the directory in which "Reduce Cancer Risk" stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Close command (File menu)

Use this command to close all windows containing the active document. "Reduce Cancer Risk" suggests
that you save changes to your document before you close it. If you close a document without saving,
you lose all changes made since the last time you saved it. Before closing an untitled document,
"Reduce Cancer Risk" displays the Save As dialog box and suggests that you name and save the
document.

You can also close a document by using the Close icon on the document's window, as shown below:




Save command (File menu)

Use this command to save the active document to its current name and directory. When you save a
document for the first time, "Reduce Cancer Risk" displays the Save As dialog box so you can name your
document. If you want to change the name and directory of an existing document before you save it,
choose the Save As command.

Shortcuts

Toolbar:

Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active document. "Reduce Cancer Risk" displays the Save As
dialog box so you can name your document.

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control

planner will look for them in this directory.

To save a document with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to save:

File Name
Type a new filename to save a document with a different name. A filename can contain up to eight
characters and an extension of up to three characters. "Reduce Cancer Risk" adds the extension
you specify in the Save File As Type box.

Drives
Select the drive in which you want to store the document.

Directories
Select the directory in which you want to store the document.

Important:
You should save all your files in the directory where you install "Reduce Cancer Risk". The Weigh Control

planner will look for them in this directory.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four documents you
closed. Choose the number that corresponds with the document you want to open.



Exit command (File menu)

Use this command to end your "Reduce Cancer Risk" session. You can also use the Close command on
the application Control menu. "Reduce Cancer Risk" prompts you to save documents with unsaved

changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most common
commands in "Reduce Cancer Risk", such as File Open. A check mark appears next to the menu item
when the Toolbar is displayed.

See Toolbar for help on using the toolbar.




The toolbar is displayed across the top of the application window, below the menu bar. The toolbar
provides quick mouse access to many tools used in "Reduce Cancer Risk",

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

To

Open a new document.

O
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Open an existing document. "Reduce Cancer Risk" displays the Open dialog box, in which you
can locate and open the desired file.

Save the active document or template with its current name. If you have not named the
document, "Reduce Cancer Risk" displays the Save As dialog box.

Print the active document.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed by the
selected menu item or depressed toolbar button, and keyboard latch state. A check mark appears next to
the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

caP

The status bar is displayed at the bottom of the "Reduce Cancer Risk" window. To display or hide the
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to navigate
through menus. This area similarly shows messages that describe the actions of toolbar buttons as you
depress them, before releasing them. If after viewing the description of the toolbar button command you
wish not to execute the command, then release the mouse button while the pointer is off the toolbar
button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.

SCRL The Scroll Lock key is latched down.



Cascade command (Window menu)

Use this command to arrange multiple opened windows in an overlapped fashion.



Tile command (Window menu)

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Tile Horizontal command (Window menu)

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion.



Tile Vertical command (Window menu)

Use this command to arrange multiple opened windows side by side.



Window Arrange Ilcons Command

Use this command to arrange the icons for minimized windows at the bottom of the main window. If
there is an open document window at the bottom of the main window, then some or all of the icons may
not be visible because they will be underneath this document window.



1, 2, ... command (Window menu)

"Reduce Cancer Risk" displays a list of currently open document windows at the bottom of the Window
menu. A check mark appears in front of the document name of the active window. Choose a document
from this list to make its window active.



Index command (Help menu)

Use this command to display the opening screen of Help. From the opening screen, you can jump to
step-by-step instructions for using "Reduce Cancer Risk" and various types of reference information.

Once you open Help, you can click the Contents button whenever you want to return to the opening
screen.



Using Help command (Help menu)

Use this command for instructions about using Help.



Context Help command

n?

Use the Context Help command to obtain help on some portion of "Reduce Cancer Risk". When you
choose the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark.
Then click somewhere in the "Reduce Cancer Risk" window, such as another Toolbar button. The Help
topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window. It contains the name of the application and document.

To move the window, drag the title bar. Note: You can also move dialog boxes by dragging their title
bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button

Minimize button

Name of the application

Name of the document

Restore button



Scroll bars

Displayed at the right and bottom edges of the document window. The scroll boxes inside the scroll bars
indicate your vertical and horizontal location in the document. You can use the mouse to scroll to other
parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the arrow keys.

a

After the pointer changes to the four-headed arrow:

1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to the
border you want to move.

2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note: This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog box with
the arrow keys.

a

Note: This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)
Use this command to reduce the "Reduce Cancer Risk" window to an icon.

Shortcut

Mouse: Click the minimize icon IZI on the title bar.
Keys: ALT+F9



Maximize command (System menu)
Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon |z| on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Next Window command (document Control menu)

Use this command to switch to the next open document window. "Reduce Cancer Risk" determines
which window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (document Control menu)

Use this command to switch to the previous open document window. "Reduce Cancer Risk" determines
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)
Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note: If you have multiple windows open for a single document, the Close command on the document
Control menu closes only one window at a time. You can close all windows at once with the Close
command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window
ALT+F4 closes the window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the Maximize or
Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications. Use this "Task List" to switch to or close an
application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the following
options:
Task List
Select the application you want to switch to or close.

Switch To
Makes the selected application active.

End Task
Closes the selected application.
Cancel
Closes the Task List box.
Cascade
Arranges open applications so they overlap and you can see each title bar. This option does not
affect applications reduced to icons.
Tile
Arranges open applications into windows that do not overlap. This option does not affect
applications reduced to icons.
Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



Choose Font dialog box

Select your favorite font for printed report of nutritional analysis or weight control plan.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



How to Lose Weight

To lose weight, one must decrease caloric intake, increase caloric expenditure, or do both.

Because fat contains more than twice the caloric value per gram of either protein or carbohydrate, the
general public would benefit from reduced fat intake. The Food and Nutrition Board's Committee on
Diet and Health recommended that the fat content of the U.S. diet not exceed 30% of caloric intake.
NutriSoft software calculates and displays graphic analysis of fat content for every food entry
(approximately 10,000 items in our database and also those from user's database) as well as for your
daily food consumption. The program also lets you set a fat warning level to easily identify high-fat
foods: when the specified percentage of energy from fat is exceeded, a red icon is displayed and
associated with a food item.

Sugar and alcohol provide calories from carbohydrate but no other nutrients, individuals seeking to
attain and maintain desirable body weight should use these substances sparingly. NutriSoft program
separates these items into their own food groups for easy identification and avoidance.

In addition, extremely low calorie diets (300 to 400 kcal per day) should be avoided because it may be
difficult to meet essential vitamin and mineral requirements on low-calorie diets. Crash diets seldom
work if your objective is to lose weight permanently. First, when the weight you lose is mostly body
water, it will come back when you return to your normal routines. Second, severely restrictive diets
are not sustainable for most people on a long-term basis. NutriSoft program helps you identify
inadequate diets. It also helps you design those that are healthy, varied and balanced because the
program lets you choose wisely from thousands of foods.

Evidence indicates that exercise burns calories, increases the proportion of lean to fat body mass,
and, therefore, raises the metabolic rate. Increased levels of physical activity are important for
attaining desirable body weights among the general population. The rule regarding exercising is to go
slow and steady. NutriSoft program provides a convenient utility to help you determine how much
energy you expend through common activities and exercises. As a result, you can identify those
activities that may be ineffective or those that are too strenuous. In consultation with your physician,
you can devise an exercise program that is suitable to your physical condition.

When you design a diet for yourself, make sure that it is varied and balanced. You should choose the
foods that you like so long as they are low in fat. Diet doesn't mean deprivation. The one simple
adjustment you most likely need to make is: reduce fat intake.

It is better to have several small meals than few big ones. People who have large, infrequent meals
tend to gain more weight than those who eat smaller quantities (but the same total) at regular
intervals. NutriSoft graphic analysis allows you to inspect and distribute your nutrient intake evenly
throughout the day as desired.

Important: The dietary guidelines contained in this program are derived from research published by US
government agencies and by private non-profit health organizations. The nutritional guidelines in this
section are for your information only. Before adopting any diet, please obtain approval from your
physician.






Print command (File menu)

Use this command to print a document. This command presents a Print dialog box, where
you may specify the range of pages to be printed, the number of copies, the destination
printer, and other printer setup options.

Shortcuts

Toolbar:

Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:

Printer
This is the active printer and printer connection. Choose the Setup option to change the
printer and printer connection.

Setu

Digplays a Print Setup dialog box, so you can select a printer and printer connection.
Print Range

Specify the pages you want to print:

All Prints the entire document.

Selectio  Prints the currently selected text.

n

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality
Select the quality of the printing. Generally, lower quality printing takes less time to
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer. The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Setup command (File menu)

Use this command to select a printer and a printer connection. This command presents a
Print Setup dialog box, where you specify the printer and its connection.




Print Setup dialog box

The following options allow you to select the destination printer and its connection.

Printer
Select the printer you want to use. Choose the Default Printer; or choose the Specific
Printer option and select one of the current installed printers shown in the box. You
install printers and configure ports using the Windows Control Panel.

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources. Specify the tray here.
Options
Displays a dialog box where you can make additional choices about printing, specific to
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>



Cholesterol-Saturated fat Index (CSl)

Foods high in cholesterol and saturated fat raise blood cholesterol level and increase the risk of heart
attacks and strokes. To facilitate the direct comparison of foods, researchers have developed an index,
the Cholesterol-Saturated Fat Index, which provides an easy way to compare foods.

In general, the lower the CSI of a food item, the lower the risk it is to your health. The program displays
the CSl value in dark blue if the food is relatively low in CSI and dark red otherwise. When your diet
exceeds the recommended daily CSl value, the total CSI value for the day is also displayed in dark red.

You can choose to show or not to show the CSI calculation by toggling the 'Show CSI' menu item under
the Options pull-down menu.
This index is available in NutriSoft Lower Your Cholesterol only.

To obtain more information about CSI, please refer to ' The New American Diet System' by S. L. Connor
and W. E. Connor, ISBN 0-671-68705-0.






